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Mapping Tool Overview

About

Design functional and emotional moods for your spaces. The ProtoPixel Mapping 
Tool gives you all the power of high-level lighting software with all the benefits of 
a short learning curve.

Features

— Offsite & Onsite mode (any device is needed to start a project)
— Content Library ready to be used
— Compatible with ProtoPixel Controllers as well as Art-Net.
— Lighting Content Preview
— Offline Backup
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Concepts

How the ProtoPixel Mapping Tool Works

The ProtoPixel Mapping Tool is a pixel mapping software that helps you map 
visual content to physical lights in the real world. To do so, you will have to match 
places in your content to individual lights in the real world. Fortunately, this is 
very easy with the ProtoPixel Mapping Tool. Some key concepts are needed to 
understand and use the ProtoPixel Mapping Tool:

Light

In the ProtoPixel Mapping Tool we use Light to refer to a single controllable point 
of light, which can only have one color. A Light will typically be an addressable LED. 
We represent it as a point in space with a given color.

Devices

Devices are how real-world ProtoPixel Controllers are represented in the software. 
Typically you would set up a Controller, fill in its Outlets, and then pair it to the 
physical Device. How fixtures are connected to the outlets of the Controller must 

Project

All these elements are placed together in a Project. A Project can be saved in a file 
for later use.

Content

Anything that produces color that can be mapped into lights is Content. Videos, 
images, and interactive animations are examples of Content.

Controller and Outlet 

A Controller represents how the physical Fixtures are connected in a particular 
ProtoPixel Controller. Controllers have several Outlets representing the physical 
connections where Fixtures can be plugged. A Controller has to be paired to a 
Device to work in the real world.
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System Requirements

System Requirements

—A computer with 4GB of RAM or more
—A ProtoPixel Node and/or a ProtoPixel Duo

System Architecture

Operating Systems 
 
—macOS High Sierra 10.13 or later
—Windows 8 or later
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Install the ProtoPixel Mapping Tool

To install the ProtoPixel Mapping Tool, please follow the steps 
below: 

	 —Start by downloading the ProtoPixel Mapping Tool from MyProtoPixel. 		
	 This will ensure you have the latest version of the tool.
	 — If you are using a MacOS, locate the downloaded dmg file and dou		
	 ble-click on it to unzip it. Once unzipped, open the dmg file and drag the 		
	 ProtoPixel App into the Applications folder.
	 — For Windows users, simply double-click on the Installer file and follow 		
	 the on-screen instructions to complete the installation process.
	 —After the installation is complete, find the ProtoPixel Mapping Tool icon 	
	 on your MacOS desktop. Double-click on the icon to launch the applica		
	 tion.
	 —On the first launch, you will be prompted to click on “Open” to start 		
	 using the ProtoPixel Mapping Tool. 

Please note that the above instructions are specific to MacOS and Windows op-
erating systems. If you encounter any issues during the installation or launching 
process, refer to the official ProtoPixel documentation or seek assistance from 
their support team.

Important: The Mapping Tool must be opened by right-clicking 
on the application and choosing the Open option. Do not “double 
click” on the application.
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ProtoPixel Mapping Tool Licenses

	 —Access this website, also 
accesible by going to “Window > 
Subscription Account”. 
	 —Enter the email address to 
which the license will be assigned and 
create a password for it.
	 — Click on the “Purchase 
now” button and follow the steps to 
complete the purchase.

Activation Token

If you have an Activation Token, 
you need to your navigation bar 
and go to “Help > Subscription” 
Next, add your email and the 
provided Token. Afterwards, click 
on “Activate”.

A web browser will open where you 
may be prompted to enter your email 
address. Please ensure that the email 
address you provide is the same one 

After clicking on the “Assign 
subscription to this Computer” button, 
a message will appear stating that 
“Your subscription is assigned to this 

A license is tied to a single computer. Make sure you follow all 
these steps on the same computer you will be using the 
ProtoPixel Mapping Tool.

Once you have purchased the license 
online, you need to add it to your 
computer. Ensure that you do not 
close the ProtoPixel Mapping Tool 
during this process.

To add your license to your computer, 
navigate to Window > Subscription 
Account.

used to purchase your license. To 
assign the license to this computer, 
click on the “Assign subscription to this 
Computer” option on the website.

computer”. Now you can close and 
reopen the Mapping Tool to see the 
license reflected in the software.

To install the ProtoPixel Mapping Tool, please follow
the steps below: 
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ProtoPixel Mapping Tool Interface

The ProtoPixel Mapping Tool user 
interface is composed by several panels, 
showing the important information about 
your project.

Toolbar
Scene Panel
Controllers Panel
Inspector Panel
Workspace

1
2
3
4
5

1A B C D E F

2

3

4

5

Toolbar

The toolbar has many tools for fast 
access, these are:

A	 Project operations: Open, 	
	 Open Recent, New, Save
B	 Undo, Redo.
C	 Alignment Operations: Align 	
	 Left, Horizontal Center, Right, 	
	 Top, Vertical Center, Bottom, 	
	 Spread Horizontally, Spread 	
	 Vertically.
D	  New Fixture Menu.
E	  New Content Menu. 
F	  Global Properties.
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ProtoPixel Mapping Tool Interface

Scene Panel

The Scene Panel lists all Entities 
(Contents and Fixtures) in your 
Workspace. With it you can:
- Select an Entity (Click).
- Reorder an Entity (Drag & Drop).
- Center your Workspace on an Entity 
(Double-Click).
- Select multiple Entities (cmd + Click).
- Select a range of Entities (shift + 
Click).

Controllers Panel

The Controllers Panel lists all 
Controllers and Outlets in your project. 
A Controller is just a group of Outlets. 
You can later bind a Controller to a real 
Device  (see Creating and Configuring 
a Controller). In the Controllers Panel, 
you can:
- Add a new empty Controller (Click the 
+ on the Panel title).
- Select a Controller or Outlets (Click 
it).

- Make an Entity non-interactive (Click 
on the Entity’s Lock icon).
- Hide a Content from your Workspace 
(Click on the Content’s Eye icon).
- Filter Entities by Name (type on the 
top Search Box).

- Hide the Outlets of a Controller (Click 
its V).
- Deactivate a Controller to stop it from 
sending data (Click its switch).
- Deactivate all Controllers (Click the 
switch on the Panel title).
- Hide the Controller Panel (Click the v 
on the Panel title).
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ProtoPixel Mapping Tool Interface

Inspector

This panel will show all the properties 
of the selected item. Some of those 
properties can be changed. The 
name of the selected item can also 
be changed just by editing it and 
pressing Enter. You can also cancel the 
edit by pressing Esc.

Workspace

In the Workspace, you can move and 
transform Fixtures and Contents by 
dragging them and using its handlers. 
Moving two fingers on your trackpad 
will move the workspace. You can 
zoom in or out of the Workspace with 
a pinch gesture or by pressing Cmd + 
scrolling up or down. The slider on the 
top right lets you manually control the 
zoom level and the bulb icon activates 

and deactivates the *Preview Mode*. 
In *Preview Mode* all contents are 
hidden and the lights are rendered in a 
more realistic way. You will find an FPS 
indicator in the bottom right corner of 
the Workspace.

Recording Input

ProtoPixel Mapping Tool allows the 
recording of output for two different 
situations: For a single autonomous 
controller and for multiple standard 
ProtoPixel Controllers. These 
recordings are only useful if you have 
a ProtoPixel autonomous Controller 
or a ProtoPixel Player.
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ProtoPixel Mapping Tool Interface

The Log Window

The Log Window shows messages from 
the ProtoPixel Mapping Tool Core. It is 
useful to debug scripting content. To 
show the log window go to Window > 
Log Window or press Cmd+L. Also, you 
can access the menu bar by selecting 
Window > Log Window



49ProtoPixel Suite: Mapping Tool User Manual

02		  Operational Guide

02	 Operational Guide
	 Workspace
	 Elements
	 Fixtures
	 Controllers
	 Content
	 Export Project
	 Recordings
	 Global Settings
	 Video Codecs
	 Spaces

52
52-53
54	
55-56	
57-59	
60	
61	
62	
63	
64

ProtoPixel Mapping Tool’s User Manual



50ProtoPixel Suite: Mapping Tool User Manual

02

Workspace

Elements

Navigating the Workspace

As you may have noticed, items 
are created in the center of the 
Workspace. To navigate through it, 
you can right-click and drag, use the 
trackpad, or use the mouse wheel. 

Selecting Workspace Elements

You can select various Workspace 
Elements (such as Fixtures and 
Contents) to operate on them 
simultaneously. To initiate multiple 
selections, hold cmd and click on the 
elements you want to select, either on 
the Workspace or the Scene Panel. You 
can also use square-select by clicking 
and dragging the pointer across the 

When you click on an element in 
the workspace, a Gizmo will appear, 
enabling you to transform it. To move 
an element, simply drag it using the 
pointer. To rotate it, drag the rotating 
handle (blue) (press shift to rotate in 
15º steps). To scale it, drag one of the 
edges of the bounding box. To restore 
the aspect ratio, use the “Aspect Ratio” 

button in the Inspector Panel.
You can also select multiple elements 
to apply these operations collectively.
When an element is selected, its 
properties are displayed in the 
Inspector Panel.

Configuring and Manipulating an Element 

To zoom in and out, you can use the 
pinch gesture or hold the Ctrl key while 
scrolling vertically.
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Elements

Aligning and Distributing 
Elements

To align the selected elements, you 
can use one of the Alignment and 
Distribution tools available in the menu.
The alignment tools include vertical 
and horizontal alignment to the center 
and edges. The distribution tools 
work in both vertical and horizontal 
directions. Alignment is always 
performed using a selected group of 
elements as a reference.

You can copy and paste Elements 
using cmd+C and cmd+V key 
combinations, or using the menu 
(Edit > Copy and Edit > Paste). You 
can select any number of items to 
be copied. Pasted items will maintain 
the properties of the original, with a 
position offset. Pasted elements get 
automatically selected.

You can perform a quick copy-
paste action by duplicating the 
items: cmd+D or Edit > Duplicate.
performed using a selected group of 
elements as a reference.

Copying and duplicating Elements
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Fixtures

Creating a Fixture

To create a new Fixture, click on 
the Fixture tool in the toolbar. This 
will display the different Fixture 
alternatives available for creation. 
Select the desired fixture type 
to create it. The new Fixture will 
appear selected in the Workspace. 
Alternatively, you can go to Workspace 
> New Fixture… > Fixture Type.

In the inspector panel, you can adjust 
various properties that will affect 
how the fixture interprets colors in 
ProtoPixel. The first set of properties 
you will encounter are the ones 
that determine the size, shape, and 
connection of the fixture. These 
properties will differ depending on the 
specific fixture. Following that, you will 
find a series of parameters (table).

Configuring Fixture Properties

White Functions

There are several ways to extract the 
white component from an RGB color:
	 Mix: This method extracts 
the white component from the color 
and uses it as the white level. Pure 
white colors will not use the RGB 
components. Avoid using this function 
in a fixture without a white component, 
as it may result in incorrect colors.
	 Average: In this method, the 
white component is calculated as the 
average of the RGB components. This 
will yield slightly whiter colors.

Color Modes

Here you select how the fixture should 
use the color from the content:
	 Original: The original RGB color 
is used.
	 Monochromatic: The intensity 
of the color is used to modulate the 
Base color.
	 Color: This will ignore the 
original RGB color altogether and use 
the Base Color directly.

Parameter

ON

Level

ProtoPixel Gamma Correction

ProtoPixel Temporal Dithering

ProtoPixel Double Points

Force Channel

Fixture Type

Custom Ordening

White Function

Color Mode

Base Color

Base Color Transition Time

Transition Delay

Element / Zone

Function

Switch on and off output for this fixture

Intensity of the light of the fixture

Apply the gamma correction to the color

Try to get fine grade colors by adding some noise

Every pixel of the fixture should be sent twice

Select the adress for DMX luminaries  

List of preset byte orders. This will depend on the fixture 

hardware 

Define the ordering manually according to the fixture

Select average or mix 

Select original, monochromatic, or color. 

Color used as a base, depending on the Color  

Set up the transition time of the colors on dynamic 

contents

Set up delay transition 

Name the fixture or group of fixtures

Parameters Table
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Controllers

To establish communication with real-
world fixtures and send them lighting 
information, we need to establish 
a connection with the physical 
ProtoPixel Controller and specify how 
the fixtures are connected to the 
device. To add a controller, navigate 
to the Controllers Panel tab and click 
on the add icon. A new controller will 
be created with a default number of 

ProtoPixel Controllers do not have 
any information about how fixtures 
are connected to them. Therefore, we 
need to describe this information in 
the software. This allows the software 
to send the color information to the 
Controller in the correct order. To 
begin, we need to add the Fixture to 
the appropriate Outlet. To do this, first, 
select the Fixture. This will display 
its properties in the Inspector. Then, 
use the list to change the assigned 

outlets. You can modify the number of 
outlets in the Inspector.
There are two remaining actions:
- Adding fixtures to the outlets.
- Connecting the controller to a device.
average of the RGB components. This 
will yield slightly whiter colors.

controller and outlet. If multiple 
fixtures are added to the same outlet, 
it is necessary to define the correct 
order in which they are connected to 
match the physical setup. To do this, 
select the *Outlet* in the Controller 
Panel and use the inspector to drag 
and rearrange the fixtures. As you 
select the outlet, a preview of its 
wiring will appear on the workspace. 
The starting point of the outlet is 
represented by a vertical line.

Configuring Fixture Properties

Adding Fixtures to Outlets

Inspector Window:
Line Section

Outlet lines and order
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Controllers

Now that we have added Fixtures 
to Outlets, we need to connect 
your Controller to an actual 
Device. ProtoPixel Controllers are 
automatically detected when they 
are connected to the same network 

If the Controller cannot connect to the 
device, its name will appear in red in 
the Controller Panel until it reconnects 
again. You might be interested in the 
DUO Controller documentation.

This typically occurs when the device 
is on a different subnetwork. Make sure 
that all controllers are on the same 
subnetwork as the computer running 
ProtoPixel Mapping Tool, and that the 
network mask allows for connectivity.

Depending on the type of LEDs being 
used, you may need to adjust their RGB 
order to accurately represent colors 
in the real world. To do this, select all 
affected fixtures and modify their “PPx 
RGB ordering” property.

Some Controllers may be inaccessible 
depending on their connection. While 
ProtoPixel Mapping Tool may be able 
to detect them, it may not be able to 
establish a connection or send data 
to them. In such cases, a warning with 
relevant information will be displayed 
next to their current IP property.

👉 👉

👉👉

👉

as your computer. To pair a controller 
with one of the detected devices, 
select the Controller (this will display 
its properties) and choose the device 
from the list. This will also display the 
Device’s properties in the Inspector.

Connecting a Controller to a Device

Best Practices

You can modify certain parameters of 
the device in the inspector, depending 
on its capabilities. Refer to the table in 
the “Configuring the controller” section 
for more details.

Inspector Window: Devices

https://protopixel.zendesk.com/hc/en-us/categories/9334941500945-DUO
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Content

Now that we have Fixtures in the 
Workspace and have mapped them 
to real-world Fixtures, we can begin 
mapping content into them. To create 
content in the workspace, we can 
either press the Content menu in the 
Toolbar or use the Workspace > New 
Content… > Menu. We then select 
the desired type of content. Some 
content types require a file to function 
(such as images, videos, and scripts). 
These contents can be created by 
simply dragging the file directly into 
the workspace. As an example, we 
could create a Test content to verify 
if everything is set up correctly. This 
content consists of four squares of 
different colors rotating.

This content defines a solid color. 
Adjust the color and temperature using 
the palette.

The ProtoPixel Mapping Tool includes 
several bundled types of content:

1	 Color
2	 Image
	 Video
4	 Script
5	 Syphon
6	 Test

**All types of content have an Alpha 
parameter that can be adjusted to 
change their transparency. Also, 
some contents can be configured to 
determine their alignment.

Adding Content

Content Types: Color

Parameter

Texture Filtering

Texture Horizontal

Texture Vertical

Meaning

Define if the pixels should blur 
between them

Offset move the content texture 
horizontally

Offset move the content texture 
vertically

Inspector Window: Color

Color ContentTunable White Full Spectrum
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Content

 This content imports an image. It 
supports the following formats:  
 
.tiff

.jpg

.png

Plays a video and maps it with the 
lights. The Inspector provides controls 
to play and stop the video. You can also 
adjust the volume and enable video 
looping.
Although the ProtoPixel Mapping 
Tool is capable of playing many video 
formats, we recommend using the 
following specifications:

- Container: mp4 (MPEG-4)
- Resolution: 1280x720 or lower
- Codec: H.264

You might find the Video Codec 
Specifications for Node article 
interesting. 

More info on Video Codecs here.

This content provides a quick way to 
test content on fixtures. It consists 
of an endless video featuring rotating 
RGB squares of different colors.

 You might be interested in Content 
from Library

You can create interactive content 
with software like Resolume, 
Modul8, Millumin, or even audiovisual 
interactive tools like Processing. By 
using Syphon technology, you can 
import image content directly into 
ProtoPixel. To do this in the ProtoPixel 
Mapping Tool, activate the Syphon 
output in the software you want to use.
Next, add a Content > Syphon and 
select the desired application from 
the Source drop-down menu in the 
Inspector panel. The content will 
appear in the view and can be mapped 
like any other content.

Image Video Test Syphon

https://protopixel.zendesk.com/hc/en-us/articles/8284891460881-Video-Codec-specifications-for-Node
https://protopixel.zendesk.com/hc/en-us/articles/8284891460881-Video-Codec-specifications-for-Node
https://www.notion.so/protopixel/Video-codecs-5d4ed609c1c349929ed97de9f727a80b
https://protopixel.zendesk.com/hc/en-us/articles/9919505090577-Library-contents-in-Create
https://protopixel.zendesk.com/hc/en-us/articles/9919505090577-Library-contents-in-Create
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Content

The ProtoPixel Mapping Tool offers 
scripting capabilities for creating 
interactive content. It is based on 
the Python programming language 
and incorporates bindings to open 
Frameworks, a popular creative coding 
library. To familiarize yourself with 
ProtoPixel Scripts, you can refer to the 
provided examples. We recommend 
using a Python-aware editor, such 
as pyCharm or Sublime Text with 
Python addons, to edit the scripts 
externally. When saved, the programs 
will automatically reload in ProtoPixel. 

With the Mapping Tool, you have 
access to various default content 
options that you can customize to 
unleash your imagination and create 
incredible new content. Library 
contents in the Mapping Tool.

- Make sure that you have installed a 
text editor on your machine.
- These instructions only work for 
the Mapping Tool (formerly known as 
Create) 3.0 or higher versions.

Script

Content Library Shaders

For advanced graphics generation in 
scripts, you can also use the pyOpenGL 
bindings after installing them 
separately.
To use a Script Content, create a 
python file and import it into the 
ProtoPixel Mapping Tool. Any errors in 
scripted programs will be displayed in 
the Log Window.
During execution, you can add various 
input elements to the properties of 
your script. The Mapping Tool will 
check for new inputs each time you 
click on the script content.

1. Go to the file package that you 	
have downloaded, which 	
contains the MappingTool.dmg file.
	
   	  a. Open the ‘examples’ folder.
   	  b. Open the ‘scripting’ folder.
   	  c. Drag and drop the shader.
py.  Python file onto the Mapping Tool 
workspace canvas.

2. Select the shader you want to 
import.
    	 a. Go to your browser and 
search for the desired shader in a 
repository, such as shadertoy
    	 b. Identify the suitable shader 
for your project.
	 c. Copy the code of the shader.
    	 d. Paste the code into a text 
code editor.
    	 e. Save the file on your machine.

3. Import your shader into the 
Mapping Tool:
    
	 a. In the Mapping Tool, select 
the shader object (represented as a 
transparent square).
	 b. From the inspector panel, 
select the shader path where you have 
stored the code. 

Please ensure that your chosen 
shader does not have any external 
dependencies (check the information 
available in the ‘iChannel’). If it does, 
it might not work in the Mapping Tool 
because those external sources would 
not be embedded.

Steps for importing shaders into the ProtoPixel Mapping Tool

https://protopixel.zendesk.com/hc/en-us/articles/9919505090577-Library-contents-in-Create
https://protopixel.zendesk.com/hc/en-us/articles/9919505090577-Library-contents-in-Create
http://shader.py/
http://shader.py/
https://www.shadertoy.com/
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Export Projects

Once the project is correctly mapped 
in the ProtoPixel Mapping Tool, from 
the menu bar select the option Project 
> Export select a location, and name 
it. The file will be saved with the 
extension .ppxexp. 
There are two kinds of projects:

1. The bare project is a file with a 
.ppxproj extension. It is created when 
you save a project. It only contains 
the essential parts for it to run on your 
computer.
- The bundled project is a file that also 

has a .ppxexp extension. It is created 
when you export a project. It contains 
a bundle of all assets needed to run 
your project on any computer (videos, 
scripts, …). this is the necessary 
extension to upload a project to the 
Node.

To export your project go to Project > 
Export, or use cmd+E.

How to Export

https://protopixel.zendesk.com/hc/en-us/articles/7244699793681)


59ProtoPixel Suite: Mapping Tool User Manual

02

Recordings and Duo Controller

In order to use the Duo in standalone 
mode you will first need to make 
content for the Duo to playback. This 
is done using the ProtoPixel Mapping 
Tool software which will allow you to 
make recordings that can be uploaded 
to the Duo.

First define the fixtures in the Mapping 
Tool that you to control using the Duo.
Make sure that you have a controller 
with 1 or 2 outputs configured and 
that these are assigned to the 
corresponding fixtures that you 
intend to make the recording for. The 
recording will capture the all of the 
information generated when you run 
the content in the Mapping Tool and 
“hit record”, this includes which output 
the fixtures are connected to.

You can now start designing and laying 
out the content in the Mapping Tool 
that you wish to capture with the 
recording process.

In the Mapping Tool inspector panel, 
you will find the Recording section.
Here you need to define the recording 
name, select your controller and the 
path where you want to store the 
recording. By default, the recordings 
will be saved in your Documents folder 
(e.g. on Windows: C:\Users\YourName\
Documents\ProtoPixel\Recordings)
You will also need to define the frame 
rate you want your recording to be 
saved.

Once you have completed steps 1, 2 
and 3 you are ready to record. Run 
the content sequence that you wish 
to capture then click on the “Start” 
button to record. Once your content 
sequence is done you need to click the 
“Stop” button. Your recordings will be 
automatically saved to the path you 
defined in step 3.

If you think that you may 
upgrade your install to use a 
ProtoPixel Node to control the 
DUO in the future now is a great 
time to export the project

Note that the format you 
must select from the 
recording panel in the 
Mapping Tool for the Duo
is V1.

TIP: Add a suffix in your 
recording name indicating the 
frame rate (e.g. “_60fps”). It 
will be useful when uploading 
the file to your Duo with the 
Player WebApp.

A REC hint will appear in the 
Mapping Tool canvas (bottom 
right) to show when you are 
recording

Create a Recording

Step 1: Lighting Fixtures

Step 2: Lighting Content Step 3: Recording Storage Step 4: Record

👉

👉

👉 👉
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Global Settings

There are several global settings that can be accessed through the global 
settings button in the Toolbar. Here is a description of each setting:

This name is used to notify you 
about expiring subscriptions or other 
installation-related events.

Installation Name

Specifies the path to a project that will 
automatically load when running the 
ProtoPixel Mapping Tool. This is useful 
for autonomous installations.

Starting Project

Enables sound processing for scripts 
that require it.

Process Sound

Sets the maximum framerate for the 
entire application.

Global Framerate

Refers to recording output for a single 
SD Controller

Manual Artner Devices

Refers to the scheduler feature.Scheduler

Refers to recording output for a 
ProtoPixel Player.

Recording

Limits the quality of the preview in 
the ProtoPixel Mapping Tool. This 
does not affect the quality of the LED 
output, but reducing it can improve 
performance.

Preview Quality

It is recommended to keep this option 
activated for better performance. 
However, some older systems may 
actually perform better with it 
deactivated.

Async Rendering

The program periodically saves your 
work so that you can recover it in case 
of an outage or a crash. If a backup 
project is found when starting the 
application, a dialog will prompt you to 
recover it.

Autosave



61ProtoPixel Suite: Mapping Tool User Manual

02

Video Codecs

To avoid issues with projects that include video files, ensure that the video codec 
is correct.

To use them, you will need to import 
the presets from the table in the 
following way:

1. Download the file Proto-RF24-
Max720p (1).json.
2. Open Handbrake
3. Click on ‘Presets’.
4. Click on ‘Import’.

If you are using the ProtoPixel Mapping 
Tool on Windows, a pop-up will appear 
during the installation process 
suggesting the installation of the 
codec pack. This message typically 
appears when you open the Mapping 
Tool for the first time on Windows, 
as well as when you try to add video 
content.

If you have ignored the suggestion, you 
can download the codec pack here.

You can find more info and 
resources here.

https://protopixel.zendesk.com/hc/en-us/article_attachments/10488551122321/Proto-RF24-Max720p__1_.json
https://protopixel.zendesk.com/hc/en-us/article_attachments/10488551122321/Proto-RF24-Max720p__1_.json
https://handbrake.fr/.
https://codecguide.com/download_kl.htm
https://mattgadient.com/comparing-x264-rf-settings-in-handbrake-examples/
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Spaces

Spaces is a tool for controlling 
various types of lighting, from 
everyday environments like offices 
to immersive experiences. This guide 
will demonstrate how ProtoPixel 
Spaces serves as the configuration 
co-pilot of the ProtoPixel platform, 
providing a control interface for users. 
It seamlessly integrates with other 
components of the suite, including the 
advanced lighting design software, 
ProtoPixel Mapping Tool, and the 
hardware device, ProtoPixel Node. 
Spaces enable users to create and 
manage their lighting environments, 
utilising moods, widgets, and rules for 
everyday use.

You can use Spaces as if you were on 
your mobile phone, but directly from 
the Project Mapping Tool. To do this, 
go to Window - Spaces. When Spaces 
is enabled, you will see an “Spaces 
enabled” alert at the bottom of the 
canvas, indicating that the installation is 
being controlled with Spaces.

For detailed instructions on how to use 
Spaces, please refer to its manual.

https://protopixel.zendesk.com/hc/en-us/categories/9334906721681-Spaces
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DMX

To use DMX, you have to edit the 
properties of the fixture (imagine that 
you created a fixture type line, which 
are several light points in a row). In the 
inspector, you will see the “PPx RGB 
Ordering” property.

This ordering must reflect the DMX 
channel distribution. In that case, the 
DMX fixture does not use a pre-defined 
layout, a custom layout can be created 
by selecting “Custom” in “PPx RGB 
Ordering”, and filling out the “custom 
ordering” section. For instance, if your 
fixture accepts 10 channels, the first 
one being intensity, the next 3 being 
RGB color, and the rest being various 
effects that you want to leave to 0, the 
layout would result in:

Letter

R
G
B
C
M
Y
W
<other>

Meaning

Red
Green
Blue
Cyan
Magenta
Yellow
White
Custom

If you add a symbol that is not on this 
table, it will be created a parameter on 
the panel, so you can manually change 
its value.

The fixture DMX addresses will start 
with 1 and accumulate the number of 
channels in the layout: 1,11,21,31 …
Then you have to connect with the 
Art-Net device (with DMX output); 

first make sure it is connected to 
the network or directly wired to the 
computer. Add a Controller, and assign 
the fixture to outlet 1 (= universe 0). 
In the Controller, you should be able 
to select the Art-Net device from the 
menu. In case the Art-Net device is not 
detected, you can add manually one. 
Just follow the next section.

To manually add an Art-Net device 
first, you have to check that you have 
manual Art-Net devices activated 
in the Global Settings. Then, select 
the controller and assign to it the 
manual Art-Net device. This device 
works exactly the same as the Art-Net 
detected devices, with the difference 
that you can manually specify the IP 
address.

Property Editing Possible Values for  DMX
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OSC Interface

ProtoPixel has a native Open Sound 
Control interface exposed in port 2345.

You can affect contents in your project 
by sending OSC messages to this 
port. The OSC address schema is like 
follows:

With those parameters:

<type> is the entity type, and at the 
moment it can only be Content.

<name> is the name of the entity

<param> is the parameter of the entity 
to be modified. You can see those 
parameter names by accessing the 
Content section in the WebApp. 

<value> is the new value of the 
parameter. It can be omitted if the 
parameter is a button.

Custom OSC bindings are also 
available in scripts. See custom_osc.
py example in the examples/scripting 
folder for more details.

Property Editing

OSC Messages Examples

If the parameter is inside a 
parameter group, you can use 
/ to separate the group from 
the parameter name. See the 
examples.

👉

Custom OSC bindings
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Integration OSC & events

You can affect the contents in your 
project by sending OSC messages to 
this port. The OSC address schema is 
like follows:

Inside a custom script, you can register 
an OSC endpoint like this:

Please take into account that if the 
number of arguments sent does not 
match the function signature, the 
message will not be delivered.

ProtoPixel Spaces can integrate 
with other elements such as 
presence sensors via its API. For more 
information consult here.

With those parameters:

<type> is the entity type, and at the 
moment it can only be Content.

<name> is the name of the entity

<param> is the parameter of the entity 
to be modified. You can see those 
parameter names by accessing the 
Content section in the WebApp. 

<value> is the new value of the 
parameter. It can be omitted if the 
parameter is a button.

Controlling Standard Contents Getting all parameters from a Content Sending OSC to Custom 
Scripts

Sending events to Spaces

https://protopixel.zendesk.com/hc/en-us/articles/8289426834321-Integration-OSC-events


67ProtoPixel Suite: Mapping Tool User Manual

03

UPD Art-Net

There is also a UDP interface in port 
2344. The mechanics are the same as 
the OSC Interface. The messages are 
composed like the following:

To manually add an Art-Net device, 
first check if you have enabled manual 
Art-Net devices in the Global Settings. 
Next, select the controller and assign. 
the manual Art-Net device to it.

This device functions identically to the 
Art-Net detected devices, with the 
distinction that you have the ability to 
manually specify the IP address.

For instance:

Interface Manual Art-Net Configuration
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For more information 
and inquiries, contact 
us at protopixel.io 

https://www.protopixel.io/

